
1 | P a g e  
 

Getting Started – American Revolutionary War 
 

Welcome to Musket & Pike: American Revolutionary War, we will use the abbreviation ARW as needed going 

forward. This guide is intended to get you playing quickly. This will be broken down into three parts, with three 

associated scenarios. The first will go over game play fundamentals – moving, firing, formations, terrain and the 

like. The second will be a Battalion Level scenario and the third will be a Company Level scenario. 

The image below gives you a quick overview of the game screen, and the various parts of it. We’ll be referring to 
these parts as we step through this tutorial. Do note that this is customizable using the “Settings” and “View” 
menus in the game and will adjust to fit your desired window size and layout. 

 

This document is not meant to be exhaustive however, so a thorough reading of all the documentation for the 
game is a must to gain a full understanding of the system. The Design Notes (Notes.pdf) document is especially 
useful for period specific details. This is accessible from the Help menu in the game, and in the \Manuals folder. 
 

 If your game isn’t currently running, select the Main 

Program icon in your game folder, or the icon created on 

your desktop during installation. You will be taken to the 

File Selection Dialog. The first scenario is titled 

“000.Getting Started.scn", select this and then click OK.  
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 This takes you to the AI Selection Dialog where you choose the side you 

wish to play. For this tutorial we will leave "Manual" selected for both 

sides. FOW (Fog of War) is the normal mode you will play in as this hides 

the A/I’s moves from you for units not within your field of view (called Line 

of Sight, or LOS). However, you may choose to play without FOW if you 

desire. In the other tutorials we will use more normal settings. 

 

 

 

 

The Rules button brings you to a page listing all the optional 

rules available to you. We will be playing with the “Default” 

rule set here, but as you gain experience you may want to 

experiment with these. These rules are explained in detail 

in the Main Program section of the User Manual, section 

9.20. You can access this at any time during game play by 

pressing the F4 key, or from the Help Menu. You can also 

rest your mouse over each one to display a brief description 

of each. 

These can be revisited in future games, but bear in mind 

that they can only be set when you first begin the scenario. 

Also, if changed, those rules will remain in effect for new games until changed. If you change them over time in 

subsequent games and later want to return to the default set simply click the Default button on this screen.  

There are 4 methods in which the game can be played: 

• Turns, with distinct melee sub-phase (default). 

• Turns, which allows everything to take place in any order within the same turn. 

• Phases, with automatic defensive fire. 

• Phases, with manual defensive fire. 

Both of the “Turns” options use what is called “Opportunity Fire” which allows the units from the opposing force 
to react to your units’ actions and conduct ranged defensive fire. A single unit can possibly do this fire multiple 
times within a given turn based on what unfolds – but this fire is at 50% effectiveness to offset this. Both “Phases” 
options allow for more discrete control of each segment with the last requiring the most amount of file transfers 
if playing by email (PBEM). The default method of play gives the best overall balance of play versus realism while 
also keeping the action moving along. Setting up each style is controlled by the optional rules selected at the 
beginning of a scenario and is covered in more depth inside section 2.3 of the User Manual. 

Click OK to close the rules window. Then, click OK to get the scenario underway. 
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 The map will appear along with a dialog announcing the current 

turn. Click it to close. (A left-click will clear the dialog box for this 

turn, but it will be reappear for acknowledgement for all future 

turns. If you right-click then it will display briefly and then clear on 

its own in future turns.) 

Note: ARW scenarios are designed as either Battalion Level (BL) or 

Company Level (CL) engagements. For BL actions, each turn 

represents 15 minutes of real time and each hex covers 100 meters across. For CL actions, each turn represents 5 

minutes of real time and each hex covers 40 meters across. It will be noted in the Scenario Description which scale 

applies to the selected scenario.  

Now a few details about viewing and moving around the game. 
 
 There are 5 views within the game, 
pictured here.  
 
They can be cycled through with 
your wheel mouse, the Zoom-In & 
Zoom-Out buttons on the toolbar, 
or the hotkeys listed next to each 
picture. 
 

 
Feel free to use these views 
according to your taste to better 
see your objectives, your forces, 
and the action around you as you 
play.  
 
Note: It doesn’t matter which map 
view you choose, in this tutorial we 
will often be using 2D Zoom Out. 
 
 

(Tip: Auto Scroll is the default and will move the map when you move your mouse to the edge of your display. If 
you prefer to use manual scroll bars, you can do so by de-selecting Auto Scroll from the Settings menu). 
 

 
 Note: You can also use the Jump Map to display a reduced sized image of the entire battlefield. Clicking 
on any point on this map will cause the game screen to “jump” there. This is exceptionally helpful in 
games played on very large maps. Use the button on the Toolbar or press the J hotkey. 

The compass is displayed in the top left-hand corner of the map when Map Labels are on (which 

they are by default) and then only in the 2D Zoom Out view. 

(Tip: To see map localities press the ` key or use the Toolbar button.) 
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 Again, you can control what is displayed on the screen to meet your 

preferences, for example this is the View menu, and you can see a wide 

variety of options are displayed. The > symbol on the same line as an entry 

indicates that a further sub-menu exists (see Highlight for example). 

The other letters or symbols listed on the right are the Hot Keys associated 

with those commands. So, if we press the letter “O” on the keyboard 

the “Objective” symbols will be turned off… and in this case that 

would be the British flag pictured at right. Press again to turn On. 

You can even hide all the units from the map (View -> Units Off) if you want 

to get a clearer view of the underlying terrain. 

When you click on a hex it is surrounded by a red hexagon. This indicates the 

current Hot Spot hex which in turn controls the information displayed in the 

Hex Info Area and the ability to assign commands to units. 

For this scenario the map will take up your whole game window regardless 

which view you have selected. This can vary widely based on the scenario 

being played – some actions focus on a tiny area of the battlefield; others 

cover huge sprawling areas that will have you scrolling and scrolling to get 

from side to side (and using the Jump Map feature a lot). 

Let’s take a moment and look at the Toolbar in more detail. In addition to 
HotKeys, this is the most common way you will interact with the game. 
 
Note: There is a detailed document breaking out each button, the command associated with it and the hotkey. 
Press F1 to access this in game, or you can go to the Manuals folder and find the mpb.pdf file.  
 

 

The Toolbar is dynamic to help meet your needs. You can click on one of the large buttons to display only a certain 
group of buttons – in the above example we have selected the Unit section. This gives us access to the various 
commands which allow us to change formations, facing, or position in the hex. 
If you hover your mouse over a specific button a tool tip will be displayed 
telling you what it does (and its associated HotKey).  

Let’s take a look at the map now. As mentioned in our introduction, this is not 

a typical scenario, but rather a series of “stations” scattered around the map 

which we will visit to accomplish specific goals. Use the Jump Map to get the 

big picture. You will see four yellow dots and many other colored dots. The 

yellow dots represent Objectives and they will be navigation points for our 

time with this scenario. Click near the top objective which will move the game 

map near a column of Continental forces. Each faction or army will have its 

own color for counters, unit/leader boxes and 3D bases.  

There are eight armies featured within ARW, with four of them making an 

appearance in these opening tutorials: 
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Continental British 

Militia / State  Loyalist / Provincial 

French German (Hessians, etc.) 

Indians allied with Americans Indians allied with British 

 Now click on another objective hex and look at the Terrain Box in the Hex Info 

Area. The Terrain Box shows that this objective is worth 10 victory points in a 

Forest hex (91,41). This is near the top center of the map. It also shows the 

Artillery Ammunition for the given side. In this case 0, as none has been 

allocated. A few other details are also included, which will vary from hex to hex. 

Some further notes on objectives: To take control of an objective you must 

occupy the hex with a non-detached combat capable infantry, artillery or 

cavalry unit. When you take control of it the flag will turn to your nation’s flag. You do not need to remain on the 

objective to retain control of it, but if you don’t it could potentially be captured by your opponent. There is a 

special type of objective called an Exit Hex. To use this, you move your forces to the flag of your nation then with 

the units selected go to Command -> Remove from map. That will remove your units from play, and you gain 

points accordingly. Generally these type of objectives will be along a map edge. 

Note: the hex location is displayed in the far-right corner of the Status Bar at the bottom of your screen.  

Take a few minutes and look around at the terrain as well. There’s Clear hexes, Wooded, Rough and so forth. If 

you press the F1 key or go to the Help Menu and choose General Help the Summary Info document (mpb.pdf) 

will be displayed. This has a wealth of information displayed in a concise format. To this particular point, the first 

item is the Terrain Effects Chart (TEC) which lists all the different terrain types, any combat modifiers they impart 

as well as movement costs, if they cause Disorder by entering, and other special notes. If you examine the entire 

map you will find examples of most of the terrain types included with the game. 

In Musket & Pike, infantry may maneuver in Column, Column of March, Line, Open Order, Block, Shortened and 
Extended Line. To alternate between these formations, use the Change Formation (Ctrl+C), Change Block (Ctrl+D) 
and Change Extended Line (Ctrl+E) buttons on the Toolbar. The other commands are also listed with the associated 
Hot keys in parentheses.  
 
Artillery may be Limbered or Unlimbered. To alternate between these formations, use the Change Formation 
button on the Toolbar (or Ctrl+C). 

 Most Cavalry and Leaders are always Mounted, with the exception of Dragoons 
who may also dismount. Cavalry may also Charge. To alternate between these 
formations, use the Change Charging (Ctrl+B) button on the Toolbar.  

Supply Wagons always move in Column or Column of March formation. 

Some units may also deploy skirmishers or squadrons. More later. 

This is the age of “Linear Tactics” – where armies fought primarily in Line or Open 
Order formation under tight control of their officers. The Brigade operated as a 

cohesive unit, and the Division as a collection of Brigades. Accordingly, you should not detach individual regiments 
and send them all over the map doing different things. There will be consequences. For example, on the turn 
following a unit departing from the Command Radius of its Brigade Commander it becomes “Detached”. With the 
default rule set, this unit will not be able to initiate melee until it returns to the command radius of its Brigade 
commander and that leader’s Command Check is run the following turn. Additionally, it will not be able to take 
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control of an objective hex. If a unit becomes Detached and then Disordered or Routed it will be very difficult if 
not impossible for them to return to good order on their own. Individual units simply did not operate 
independently like this in the late 18th century. When a detachment did take place, it was to guard and hold a 
town or to escort a supply column – not venture off on offensive operations by itself.  

 
The following image will display some of the tools available to you to help maintain Command & Control. In this 
image the Brigade leader is selected, and then the menu View > Command Range (C) option is selected – which 
shades everything outside of that. Use the Jump Map to return to the topmost objective so you can replicate these 
settings. 

 
Additionally, the View > Highlight > Organization 
command (Q) is used which surrounds all his 
troops with a yellow border, but also places the alt 
highlight (orange) around the selected unit and his 
superiors in the chain of command – pictured here 
is his Divisional commander. 
 
You can repeat the process, but this time select 
the Division commander, and you will see that all 
of his Brigade leaders start the scenario inside of 
his command radius.  
 
Note: If a Brigade leader gets Detached from his 
superior it only impacts his ability to pass 
command checks. It does not impart the same 
Detached effects to his troops as when they 
detach individually. See the User Manual section 
5.4 for an in-depth discussion on command checks 
so you can grasp the importance of the chain of 
command. 

 
Now we will spend some time looking at the various units on the map and explore some of the actions we can 

take with them. 

Very Important: A unit must be Selected to accept any orders you give it. Its background will be “highlighted” or 
become brighter when it is selected. 

 

 

In addition to the information shown on the front of the unit card you will also want to right-click and review the 

information on the Alternate view. Further information about the unit’s place in the overall force organization is 
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included as is critical information about its armament, range and the amount of the available hex frontage the 

unit takes when in Line formation as pictured. The percentage will vary based on the formation the unit is in. 

 

Beginning near the top objective we have the column of Continental troops moving down a road. We are going to 

use this force to explore a new feature that has been added to the series – Column of March (CoM). The intent is 

for CoM to be used to move troops over long distances and through terrain you are relatively certain is free of 

enemy combatants. It has your units strung out along the road so that they get the Road Movement bonuses 

(reduced movement points cost and no disorder from obstructed terrain). We are going to change the entire 

Division into CoM at the same time. To do this select MG JA de Kalb at hex 58,13 and then use the Hot Key combo 

of Ctrl + K (or you can use Command -> Change Column of March). 

 When you do this a dialog box will appear – select the Yes button 

and the entire command should switch to CoM. 

If you select only an individual unit the entire command will not 

be impacted, only when a Leader is involved. This can be issued 

to a Brigade or Division, but higher organizations cannot be 

switched at once. The units do not have to be in adjacent hexes 

either to switch. To change out of CoM use the same process, but then click No. 

Depending on the Parameter Data File (PDT) settings and the size of the individual unit, a second counter may be 

created when a unit goes into CoM. See section 4.3.12 for further details on CoM. 

Note: CoM functionality is not available in all scenarios. Generally, it is not active in Company Level actions as the 

smaller units are assumed small enough to fit on the roads as is. 

We’ve switched to this formation – now let’s move the entire command. Our General started the scenario on the 

side of the road for illustrative purposes, so he will need to be moved back to the lead hex. Do this by selecting 

him and right-clicking on hex 58,12 – directly above him. Then hold down the Alt key and right-click a hex further 

down the road. I selected 64,15. As you can see from the image below, the entire column moved along behind 

him. This is called Travel Movement and is not limited to just roads but can be used any time you want a collection 

of troops to follow along in a single 

column. 

Some points here. In most cases you 

should have your leader stacked with the 

top unit in the column so they are not 

exposed. We did not do that here simply 

to reduce the complexities of the 

illustration. Normally the Division and 

Brigade leaders would be stacked with 

the lead unit, you would change to CoM 
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and then issue your movement orders. Additionally, this style of movement can be used for 2 units or 200 units, 

as long as they are adjacent to each other they will move. There are many caveats that you will learn with time 

where good force management will yield the best results. See section 5.2.13 of the User Manual for more details. 

Before we move away from this group click on the last unit in the column. This is 

a Supply unit, and its role is to supply small arms ammunition. Each unit (Infantry 

& Cavalry) is deemed to have a certain amount of ammunition with it at the 

beginning of the scenario. As the game progresses a check is performed each time 

ranged fire takes place and there is a percentage chance of going Low Ammo, or 

if already low they can go Out of Ammo. In order to replenish there must be a 

Supply Wagon within 5 hexes at the beginning of the turn. If the wagon has 

enough supplies the unit(s) will be replenished. In many scenarios wagons are worth points for capture as well, so 

you get an added bonus above depriving your enemy of ammunition!  

Use the Jump Map again and you will see a light blue column directly south of the units you have been working 

with. Click near there now. This brings us to a collection of Virginia and South Carolina Militia moving down a road. 

Note, these units are in Column formation, so they do not get the Road Movement bonuses, however they are 

still very mobile and can move through a variety of terrain at a decent speed. In most cases they will not Disorder 

either when moving through Woods, Rough or Marsh terrain. This is a formation you want to use where you are 

unsure of your surroundings, or you know hostile forces are near. These units are positioned assuming they have 

come out of CoM on the previous turn and they are now moving down to deploy in the nearby fields. They can 

either continue to move as a cohesive unit, or fan out now to cover a wider area. Their firepower is not significant 

in this formation, but it is much better than in CoM, and they have great mobility. 

 Before doing anything with them though, look at the unit in front of the column 

a few hexes, at 70,40. This is a special unit in that it is designated as a Light unit. 

These units are capable of breaking down into skirmisher companies, which we 

will do in a minute. The + also denotes that the unit can form Open Order. So, we 

have a choice to use Open Order or Skirmish companies. A skirmisher cannot 

form Open Order as it is already in a looser, more flexible fighting stance than 

Open order provides.  

Select this unit and hit the Ctrl + S hot key combo. You will see a skirmish company was created 

and you now have two counters. In this scenario the PDT value for Skirmisher Fraction is set to 10, 

so you can break this unit down into 9 skirmisher companies of 25 men each and then the “parent” 

unit of 25. These units are good for scouting ahead of your main force or defending in obstructed terrain, such as 

forest, a village or large buildings. If they get caught out in the open, they can be overrun by charging cavalry or 

pushed aside by larger formed infantry units. So, keep them in a scouting and harassing role for the most part. 

 Go ahead and deploy a skirmish screen out ahead of your 

column and then bring the balance of the column forward. 

Your deployment should look something like this: 

 In the next turn I would change my units to Line formation 

behind the skirmisher screen, but they do not have enough 

movement points left now. Let’s move on to the next group 

of units – the two Cavalry counters right below the current 

forces. 
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These two units represent two common types of cavalry you will see in the game. Irregulars and Dragoons. 

Irregulars are often used for mounted Militia which are not necessarily highly trained but are skilled horsemen. 

These forces are generally best used as scouts or escorts for supply columns. 

Dragoons on the other hand can also serve as scouts, but they can also dismount and 

conduct harassing fire. They are good for masking a retreat or pinning a force and 

engaging them while the balance of your columns advance. When Dragoons dismount, 

they are automatically in Open Order. Note: These images are done with a different 

symbol set which can be changed from Settings -> Unit Symbols -> Block. 

These are both very versatile units but should not be confused with much of the Cavalry 

on the European continent at this time. While charges are possible, it is not an ideal use  

of these forces. They are the eyes of the army so keeping 

them moving and fluid will yield the best results for you. Both of these are complete 

units, and as such will only benefit from Road Movement bonuses if they are 

changed into CoM. A Squadron of cavalry however will automatically take 

advantage of this movement benefit. When a squadron is broken off a main cavalry 

unit the line denoting Strength will be changed to Squadron. 

 Let’s move to the right and explore the next group of units. Starting some hexes 

above the objective at 91,41 we have what are known as independent skirmishers. 

These units did not break off a parent unit, like the ones we worked with a moment 

ago, but rather they are permanently in this Skirmish formation. They do benefit from 

Road Movement bonuses and have their own leader. Like the other skirmishers, 

these should primarily be used in obstructed terrain. 

Going down to the objective at 91,41 we have another collection of units. Here 

we are going to illustrate the differences between how Line and Open Order 

operate in wooded terrain. Select the 2nd Orange County NC Militia at 91,41 by 

double-clicking the hex. This will select both the unit and the two leader counters 

stacked with them. Now right-click one hex up & right into 92,40. What 

happened? Right, your unit Disordered. The remaining points available to the unit 

have been cut in half and if the unit was attacked it would defend at 2/3 

effectiveness in melee. 

 Now let’s go over to the Light unit at hex 95,41. We see it has a + mark next to its 

type designation – that means it can form Open Order. Select that unit and then 

issue the command to switch into open order by the menu option or the hot key 

combo Ctrl + V. Now right-click into a wooded hex and you will see that not only 

will your unit move, but it will also not Disorder. This is a looser fighting formation 

that allows flexibility when moving through Forest and Orchards. No Disorder will 

take place there, but these units can still Disorder in other terrain. 

Another new feature introduced with this release is the ability for units to automatically recover from Disorder 

that was the result of movement only, such as (but not limited to) crossing a Stream or a wooded hex. Disorder 

from combat is not included with this. It is assumed our unit that was in Line would have stopped and dressed 

ranks at the end of their turn, returning to good order at the beginning of the next. 
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Now we are going to work with some Crown units. So go up to the Toolbar and click on the 

clock, which will be roughly in the middle of the screen. This advances the turn. You will be 

prompted to save the file, which you can do with the default file name of battle.btl and click 

the OK button. Next the box will display telling you it is the American Melee phase. We have 

no melees to conduct so go ahead and advance the phase again. Now it’s the Crown turn. 

User your Jump Map and go down to the third objective hex, and the collection of British units gathered there. 

The first thing we are going to do is conduct another type of group movement called Attack Movement. To do this 

double-click the unit and leader at hex 82,110 which will select them both. Then, press and hold the Shift key and 

right-click a distant hex. Your result should be something like the image on the following page. 

 This is an exceptionally useful way to move an entire command that is 

deployed for an open field battle. You retain your positioning and move 

everyone at the same time. There is no limit on this command beyond all 

units being in the same formation and facing the same direction. As long 

as it is a contiguous line of troops everyone moves. 

Now go over to the units to the left of the objective. Select either one and 

right-click a hex 4 or 5 spaces away. Your unit should move to the 

destination, or as far as its available movement points will allow. With the 

other unit you can try the drag and drop method, which works in much 

the same way. Select and hold your mouse button down, move over the 

desired destination hex and release the mouse button, the unit will move. 

We have now demonstrated a number of different ways to move a unit, 

or a collection of units, a single hex or many hexes – depending on the 

need. The intent here is to show you that when the circumstances are right you do not have to manually move 

each and every unit one hex at a time. This will save considerable mouse clicks and time. 

In this same area we have a variety of artillery pieces and some 

supply. We are going to take the two-gun battery at hex 78,112 

and move it forward one hex and then unlimber it – or place it in 

a formation where it can fire. Double-click the unit, then right 

click to move one hex up-right and then use the Ctrl + C or Change 

Formation command. The battery will deploy and it will be ready 

to fire on the following turn. 

Most artillery will need to wait till the following turn in order to fire. Light artillery is an exception in that it can 

fire immediately. Occasionally some Heavy Artillery might require setup, so a “Setting Up” message would be 

displayed over the unit image and it will take a number of turns until it is ready to fire. 

 Next look at the column coming up the road near these troops. This is two artillery batteries and 

one supply unit. Select the first unit and right-click on the next road hex. Note that the unit paid 9 

movement points, which is the cost to move across a Clear hex + 2 for the elevation change, rather 

than the 4 points for Road. These units must be placed into CoM as well if you wish to get the road 

bonus. Again though, this should only be done when you are not in danger of being attacked. Now 

place that unit in CoM (with Ctrl + K) and move on up the road as far as you can. 

Note: If an artillery battery has three or more guns it will automatically generate a second counter 

when switched to CoM. 
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Now you can repeat the process with the following battery. Another wrinkle associated with CoM is, a unit must 

switch back into standard Column before it can unlimber, so an important aspect to keep in mind. A unit in Line 

or Column can switch into CoM, but coming out of it always goes to Column. 

Artillery Ammunition is listed in the Terrain Info Box, as we mentioned early on, and that represents a central pool 

for the entire army. As long as an artillery battery is not Isolated then it will be able to fire until the pool drops to 

zero. The amount will increase when artillery reinforcements enter the map and will decrease if your artillery units 

get captured. Note that the Crown forces have 20 artillery rounds assigned for this exercise. 

Before we leave this area look above and to the left of the objective and you will see a variety of terrain features 

that we will collectively call “works”. 

Each has its own function and can provide a 

certain level of protection to units stationed 

behind them. All will cause Disorder for a unit 

moving across them in Line, outside of 

Breastworks. For Column only Trenches and 

Abatis will cause Disorder. These features are 

included in the Summary Info document 

mentioned previously (F1) and are also 

discussed in the User Manual. When FOW is in 

effect all are hidden from you unless they are 

within LOS, with the exception of Fences. 

For our last stop, use the Jump Map again and bounce to the area around the bottom objective. Now we have a 

combat situation before us. We will conduct ranged fire with both our infantry units and artillery and then we will 

conduct a melee. Let’s tackle the artillery first. 

 I will always fire off my artillery first, unless of 

course I plan on limbering up and moving away 

during the turn. I also generally use the Artillery 

Dialog (Ctrl + A) to do this, so go ahead and open 

that up – it’s the blue icon with the artillery piece 

on it. 

 

To the left you will see the dialog open. Double-

click the highlighted line in the dialog to move the 

hot spot (red outline) to the relative Artillery unit. 

You can also see that the available target has a 

yellow highlight around it. This way you don’t 

have to guess or work out what is in range – the 

system shows you your options. In this case we have only one, so right-click on that unit to fire the battery. If you 

are like me, you got a “No Effect” message, which is not surprising since the unit is up in the trees. 

 Now select the unit closest to the opposition and then press Shift + F, which highlights the Firing Range. This not 

only displays your available fire arc but also gives the range at which you can fire. Now press and hold the Ctrl key 

which places us in Fire mode and right-click on the center militia unit. I was rewarded with inflicting a 1-man loss. 
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 You can have more verbose reporting if you wish by 
going to the Settings menu and de-selecting the On Map 
Results option. That will display a dialog box with 
information that must be acknowledged after every 
combat action. 

If you wish to place the game in Fire mode for a prolonged time so you 

don’t have to hold the Ctrl key, you can do so by selecting the far-

left green button on the toolbar. I generally prefer to swap between 

movement and fire as I cycle through my available troops, so using 

the Ctrl key is the easiest for me. 

The direction a unit 

faces is important. 

Select (double-click) 

the Royal North Carolina regiment in hex 78,162 on the edge 

of town. Click Counterclockwise on the Toolbar. If it possesses 

sufficient movement points, the icon will turn reflecting its 

new facing and its Unit Box will show its Line formation 

pointing northwest (or up-left). You will see the firing arc 

changed and now no opposing units are within range. Facing 

is important during combat. A unit may only fire at a target 

that it faces. Also, fire taken outside a unit’s facing causes a 

severe "enfilade" penalty. Also, the two hexes immediately in 

front of a unit are those it exerts a Zone of Control (ZOC) over. 

If an opposing unit enters one of those hexes their movement points drop to zero for the remainder of that turn. 

Normally you will want to have your infantry in Line formation when entering combat. Line formation gives them 

more fire power, and it puts them in a better position to defend themselves as well. 

Go ahead and press Shift + F again to clear the Fire Range mask, as we are going to 

move a unit in position to conduct a melee. Take the Loyalist unit on the right side 

of the line and move it towards the tree line, adjacent to the militia units. You most 

likely took some fire as you did so! This is opportunity fire and will happen as you 

conduct your actions. 

To Melee you must be in an adjacent hex to the target unit. It is possible to add 

multiple attacking units to a melee, either from the same originating hex or from 

multiple adjacent hexes as long as you remain under stacking size limitations. 

 Now to be clear, this melee we have setup is not a great one. We 

are attacking uphill against a good order defender ensconced in some woods… so not something 

you will usually want to do. But for our situation it will illustrate the process. 

Go ahead and advance the turn and it will place us in the Crown Melee Phase. 

To initiate a melee you select your attacking unit(s) and then drag and drop them on the 

destination hex. If you wish to add a unit from another hex, repeat the process. It is advantageous 

to include a leader with a melee, but only one is needed, as only one will be used for the calculations. Any more 

simply place those leaders at risk of loss.  
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When the melee is setup and we get an indication on the map. We also get a dialog displaying the predictions of 

the melee, like I said – not good odds. Generally with FOW in effect we wouldn’t get so much detail in the report. 

Close the dialog, the defending until will likely fire, and you can execute the melee. This can be done by pressing 

Ctrl + P or clicking the button on the toolbar. The melee will resolve; the results will display on the screen – and 

you most assuredly failed to take the destination hex! 

 Another item to look at here. Click on hex 77,165 and you will see a collection of barrels. This 

represents a Supply Source, or just “Source” as the label in the Terrain Info Box will display. The 

sole function of this hex type is to prevent isolation. You will often find these placed inside a fort, 

fortified town or on an island where troops are stationed. This allows these units to conduct a 

normal defense without suffering the effects of isolation if they become surrounded. It’s important 

not to confuse these with Supply Wagons – a Source will not resupply your small arms ammunition. 

We can tell the time of day or any special weather conditions by looking at our status bar. If those details don’t 

display, then click on any empty hex and the bar will update. 

 

Ok, so that concludes the first stage of your training. You know how to load a scenario, view the map and units to 

gain information. You can move and fire your various unit types, so you are now ready to actually play a scenario.  

 When you are ready go to the File menu in the top left-hand corner and choose 

“Selection…” – this will open the File Selection Dialog Box where you can select the second 

scenario, 001.Getting Started BL. 

We are presented with the A/I selection 

Dialog and this time we are going to select 

Automatic with FOW for the American 

forces and Manual for the Crown. We’ll 

leave the Rules at the default selections, so 

when ready click OK. 

We see two objective hexes up ahead, both along the main road. Opening the Victory 

Conditions dialog  (Alt + Y) we see the following screen.  

 Our Objective for this scenario is to dislodge the 
American forces from the positions in front of us, 
capturing the objectives and inflicting more casualties than we take. Ideally, we 
will completely break their force and disperse them. 

These values will be updated as play progresses, but we see it is currently a 
“Draw”. So, the burden is on you to attack and change that situation, as you 
likely derived from our initial description. 
 
If you can take and hold the territorial objective hexes and inflict greater 
losses on the Americans than you take, you will obtain a Minor Victory for 
sure. However, if you take those hexes, but take a brutal beating in the 
process, you will not obtain a victory. 
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As you can see from this screen, you gain points for inflicting losses, but you also have points deducted from you 

for losses you suffer. The 0/0 display for artillery represents guns destroyed / captured. 

Keep in mind, as combat progresses, your troops will suffer losses, gain fatigue, and have a reduction in morale. 
All of this will cause them to be more “brittle” – which means they may, or may not, execute the commands you 
issue them. They may even run away! Watching fatigue levels, maintaining command and control, and maintaining 
solid formations are all significant keys to your success. Again, once you get the basics of play down you will want 
to give the User Manual a thorough reading as this will provide ample details on these topics and more. This and 
other reference material is accessible from the “Help” menu within the game, or by pressing the F4 hotkey, or by 
browsing to the \Manuals folder where the game is installed on your computer. 

As you progress though the scenarios you will want to learn details of how battles were fought during this time 

period, allowing the different “arms” of your Army to complement each other – softening up targets with artillery 

or infantry volleys and then following up with close infantry support – bringing the bayonet to bear. The game 

engine is designed to reward good tactics and penalize poor ones but not prevent you from doing things that were 

not done historically. 

As you step through this scenario you will find things don’t always go as planned. If desired, you can start the 
scenario over from the beginning by going to File -> Selection… and start over. 
 
Let’s jump into the scenario then and learn how to interact with our pieces – so we can get our command doing 

what we want them to do. 

We are presented with a battlefield where our forces are emerging from a wood lined road, our scouts are fanning 
out probing for the opposition, and we catch a glimpse of some units on the ridge in front of us. We most likely 
are not seeing the entire American force. This is because we have FOW in effect and so will only see units within 
our Line of Sight (LOS). Our flanks are bordered by a couple of streams and associated marshland, so we have a 
relatively narrow path of advance to consider. We have no intelligence to provide any information as to the size 
of the opposing force, only that they are standing in the way of our advance.  
 
We have a relatively small force at our disposal. The right flank appears to offer a bit more open terrain and as 

such we have deployed our lone cavalry unit and attached Light artillery battery to explore that area. On our left 

we have a lot more woodlands, and as such it is quite possible to be filled with our adversaries. While the way 

straight forward is only sparsely wooded, we can’t really afford to only focus in the center and plow ahead, as that 

will potentially leave harassing troops in our rear, exposing our supply line to further harassment. 

The following image is my rough plan…keeping in mind, that no plan lasts past first contact! Normally we would 

want to maintain a reserve, but with limited forces we need to get our entire force moving forward. In the event 

resistance is found on either flank the closest brigade can shift to cover that new threat. 

Note: Not every order to change formation or advance will be successful. The presence of the enemy may be 
sufficient to interfere with the attempt. This presence is called the “Threat Value”. If you right-click on the Terrain 
Box you will see the number of troops / and the threat value currently exerted on that hex. Note that the number 
of men is the “men equivalence”. In our current scenario 1 cavalry trooper counts as 3 men and one artillery piece 
counts as 100 men. That’s the amount of space they take up in a hex. Try a few hexes to see the differences.  
 
Right-clicking a Unit Box will show the percentage chance that formation change will be successful as a result of 
any threats, if present. The absence of a percentage implies complete success. Generally, you may change 
formation so long as a unit possesses sufficient movement points to do so and the threat is low, and before it has 
fired. Once a unit has fired it is done with actions for that turn.  
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From this point on, our details and results will vary so I will give general guidance. You might encounter fire from 
a unit when I didn’t, become Disordered from a move I didn’t make, etc. Go ahead and start by moving your forces 
forward. Move your skirmishers units first, so they will flush out any hidden units they encounter before you put 
your main regiments into motion. In addition to the combat forces, don’t forget to bring your Supply up behind 
them as well and keep it within reaching distance of your rearmost troops, at least. Keep Leaders stacked with 
combat units whenever possible. 

 
And sure enough, as one of my skirmish companies moved forward they 
uncovered the presence of more troops on a further ridge, so caution is definitely 
warranted!  
 
And with further movement even more are fleshing out… definitely have a 
sizeable force ahead it seems. Before I make any solid decisions on my 
deployment though I want to finish pushing my skirmisher screen out as well as 
getting my cavalry scouts out on my right flank. Once done I will have enough 
intelligence to determine where to send my regiments for the most effect. 
 
Regarding my cavalry, I break off a squadron from the main force and send it 
scouting ahead first. I push it a good way forward and eventually a skirmish 
screen is exposed… interesting, no formed units are in view though. I have limited 
movement points left so I will stop there and bring up some more cavalry. First 
though I will detach another squadron to escort the artillery when they become 
available. Note: If you look at the Units -> Releases (Alt + J) you’ll see they are 
due to release on the following turn with a High degree of certainty. 

 



16 | P a g e  
 

 
 
Now we have a bit more information. Our left is still undefined, and that will need to be resolved as soon as 
possible, but it seems reasonably certain that the main body of opposition lies across our path of advance. So by 
and large our initial plan can move forward. I’ll be a little more conservative with Rawdon’s Brigade, keeping it 
from becoming fully engaged until the contents of the left woods is revealed. So, go ahead and bring your column 
forward. It is suggested that you remain in Column formation for Webster’s Brigade because you know hostile 
units are in the vicinity. Depending on how aggressive they are you could be engaged in close combat on the next 
turn, and CoM is not the formation for that. You could switch Rawdon’s Brigade into it to get them up more quickly 
but ensure you end your second turn with them in standard Column. 
 
With all movement completed we can check for any units that are able to fire. Toggle the game into Fire Mode by 
depressing the icon on to toolbar and then hit the N key – which is the “Next” command. The game will cycle to 
each unit that is eligible to fire, and you can fire them if you wish. Once all units are considered advance the turn, 
save the game file when prompted and proceed to your melee phase. Using the N key again will tell us if anyone 
is eligible to conduct a melee. Note: It is not advisable to initiate a melee with skirmisher units unless the defender 
is a supply wagon or lone leader, or a very depleted unit. Their role is to harass with ranged fire and slowly give 
ground when pressed – not to engage in hand-to-hand combat! 
 
Advance the turn again and the A/I will conduct its turn. You will see everything the A/I does within your LOS. 

Once the A/I completes both its phases the turn will pass back to you.  
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Note: You can use the Speed Controls at the top right-hand side of the Toolbar to 

control the speed at which the AI operates or even Pause the action. Each command 

also has a Hotkey (F5 – F9). 

You should have received a Command Report telling you that your Legion Artillery has been released, click OK to 
acknowledge this. The information contained in this report will vary as the scenario progresses, but it is often of 
critical importance to your operations, so pay close attention. 
 
I now have a bit more information available to me. I see a Militia skirmisher unit on the edge of the woods to my 
left – that tells me those trees are most assuredly occupied with more troops. I’ve also had some opposition push 
forward into my skirmish line in the center, and some probing with cavalry on my right flank. From what I am 
seeing there I feel reasonably confident that they are a screening force and no major thrust is going to come from 
that angle. So, my plan generally remains unaltered.  
 
The strength of the British troops is in their discipline. I want to get them deployed into Line formation this round 
and begin moving them forward. Bringing them to the point of contact as soon as possible so that they don’t have 
to soak off losses from the ranged fire of the American forces. Here’s a shot of how I end my turn two movement. 
 

 
 
I advance the turn and let the AI process… I see more units coming into the line and a few more skirmishers on 
my left. Time to get my troops moving forward and making some progress. Move your forces to contact to try and 
dislodge the defenders. Keep in mind, Open Order and Skirmish formations operate smoothly within a wooded 
environment, Line will Disorder with every move. Your fire power is more concentrated, but on the move, you will 
be better served by the loose formations. 
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Turn five ends with not a whole lot of headway made – the AI is putting up a stiff defense with one regiment and 
a few skirmish companies holed up in a clump of trees in the center of the line. Where I have caught them in the 
open though my regiments have prevailed. I also have my artillery battery deployed in a commanding position 
delivery supporting fire. Here’s how my turn six ended. 
 

 
The defenders pushed back on the following turn, capturing the objective back and also pushing one of my 
regiments back, but the center of their line is blown, and the Volunteers of Ireland are making headway against 
the Militia that had come up fill the gap.  
 
I keep the pressure up… my forces are getting tired, but so are the defenders. I now have the central position 
firmly in hand, with one of the batteries captured and the second one surrounded. I also by a stroke of luck 
captured the American commander, General Gates who will make a fine prisoner of war.  
 
On my last turn I captured the second deployed battery and solidified my central position, but I am by no means 
in a position of strength. The scenario ends and the opposing forces are revealed showing a dispersed American 
force, but by no means completely vanquished. The Light units on my left are still solidly engaged, and two rally 
points are defined with the defenders regrouping. The Victory Dialog says I have achieved a Minor Victory, but I 
have not completely vanquished my foe. 
 
No two playthroughs are exactly the same… go ahead and play the scenario again and try to better your results, 
or you can switch sides and try it as the Americans. When ready go on the scenario 002.Getting Started CL – to 
experience a Company Level treatment of this same situation. 
 
For this next exercise we are going to switch sides and control the American forces. The first thing you will notice 
is the significantly greater number of counters. Each regiment is broken down into multiple counters, or 
Companies. This allows greater control of your forces – covering a wider front for example – but each unit is 
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(obviously) significantly weaker than a full regiment. This also allows a wider diversity of units to be covered. For 
example, look at the Light Militia units on your right flank. We see the actual county names the units come from, 
instead of just one big Virginia or North Carolina Regiment. This style of play allows you to maintain a reserve 
more easily and cycle units out of the line to rest when heavily engaged. But with that greater fidelity also comes 
increased management, so it’s a give and take. Many of the group movement commands we talked about earlier 
in this tutorial will be very important when playing this style of game. 
 
Due to the smaller size of units, the CoM formation is not used in Company Level scenarios by default. It is possible 
to edit the PDT files and make it active if you wish, however. Details can be found in the Scenario Editor manual. 
Maps will be bigger as each hex represents 40 meters rather than 100, and weapon ranges will also be greater. So 
rather than engaging in firefights at 2-3 hexes you will start doing so at 6-8 hexes away, depending on the weapon 
being fired. Leaders are also different with Battalion (Bt) being the lowest level, then Brigade, Division and on up. 
The Command Range for a Brigade Leader is larger, for example, again to accommodate the different scales. Time 
is also segmented into 5-minute increments, so we have three turns for every one in the previous scenario. 
 
A further consideration is Frontage. With the smaller hex sizes, you can’t fit as many men on the firing line, so you 
need to be careful operating with Stacks of men. The total stacking limits for a hex do not equate to the number 
of men that can bring their firearms to bear out of a 40-meter frontage. Yes, it’s helpful to have a stack when going 
in for a melee, but not as much when trying to conduct ranged fire. Note the image below. The two units on the 
left are on the “top” of the stack, so they can fire. The two units to the right are Masked – meaning they are behind 
the other units and cannot bring their muskets to bear. 
 

 
 
This impacts Battalion Level scenarios as well, but it is more pronounced in Company Level due to the increased 
number of counters. See section 5.3.9 of the User Manual for further discussion on this topic. 
 
So, now we find ourselves as the blocking force. We are familiar with what lies before us and their goal. Our job 
is to stop their advance cold and send them back where they came from! As you saw, albeit from a detached point 
of view, certain elements of the American forces can be a bit brittle when things get close and hot. So, we’ll want 
to be smart in the management of our forces.  
 
Note the line behind the center objective in the following image. That is to denote a ready reserve, possibly a full 
50% of your Continental forces. You can press forward with some, and apply pressure on the flanks, but you need 
to have a healthy reserve force to counter unexpected developments. Also note, the Militia coming in from the 
rear is poor quality. Ideally you get them into position where they can deliver a few volleys over some open ground 
and then pull back to another defensive position. Move through the trees in Column formation so they don’t 
become Disordered, as you’ll notice none of them can form Open Order.  
 
Below is a suggested plan of action. 
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A tool I find very useful is Highlight Organization (Q). This places a border around all the affiliated units to the 
selected one. In the picture below and at left the unit is selected and so it has an orange highlight, all of its fellow 
units have a yellow highlight. The leaders up their chain of command also have an orange highlight. The second 
image is using the Divisional Colors (Z) option, which color codes all related units. Personally I find the first example 
much more focused and useful. 
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Go ahead and put things into motion. I’ll step through mine and we’ll meet back up with a progress report after 
the forces are fully engaged. 
 
In my match I’ve executed my plan and by turn five I have my light troops harassing the Crown forces flank which 
in turn is limiting the troops they can commit to the main assault up the road. They are applying heavy pressure 
to my center and delivering a whoopin on my cavalry on the left. In fact, I need to divert some companies to that 
side to try and counter the Legion Cavalry I’ll soon be finding behind my lines! 
 
Turn six sees me having to commit some of my reserves to my center in order to plug the holes that have been 
created. With the close density of units, the possibility for a chain route is a real concern. But the congested 
landscape leaves me little choice. I specifically avoid engaging in melee, relying on my ranged fire to whittle the 
attackers down. They have no such qualms however and continue to bring the cold steel into play with each 
passing turn. By turn seven I experience my first batch of units turning tail from the fray… five companies head for 
the rear. Thank goodness I held a reserve! 
 
Turn eight seems my left stabilized as their cavalry falls back to regroup, but now there’s significant pressure on 
my right, as my light forces are steadily pushed back. My original center line is holding, but most of my Continental 
forces have been committed. That means there’s a good chance the Militia will be seeing some action today. 
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I retired my line a bit over turns nine and ten in attempt to regroup and dress ranks. The Crown forces took it as 
an invitation to press forward. My right flank is now in a shambles, but I have a line of Militia waiting to deal the 
Loyalists a blow when they come into the clearing.  
 
As the turns march on it is clear my intentions of driving the Crown from the field are history. I have reformed my 
line, and it is reasonably solid, but my troops are brittle in many cases and as the Crown units close again and 
again, more men take off for the rear. I have lost the central objective to repeated attacks. Apparently, these Brits 
have been promised something good for their successful efforts today!  
 
On turn seventeen I launched a counterattack in hopes that I could reclaim the central objective. Some progress 
was made, but it remains to be seen how far it will go. By turn nineteen I was successful, but the pressure of the 
Crown troops was not wavering. 
 

 
Turn twenty begins with me holding a Minor Victory, but a very long way from a Major. How about you?  
 
We’ll stop this walk through now, but hopefully this three-step process has brought you from learning the basics, 
to playing a scenario with minimal guidance. 
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Further Information 

This guide is designed to give you a basic introduction and feel comfortable with what’s going on in the War of 

the Austrian Succession game, but it is no substitute for the User Manual, which is the series’ rule book. The User 

Manual will expand upon everything discussed here and cover the issues of campaign play, leadership, morale, 

and supply amongst others that will allow you to fully enjoy the game. The General Help section also discusses 

the various elements of the interface in helpful detail. You can see this whilst playing by pressing F4. 

The General Help shortcut provides you with Summary Info such as Terrain Effects Chart, Weapon Effects Chart, 

Toolbar definitions, hot key listing, etc. You can see this while playing by pressing F1. 

If you wish to delve inside the game designer’s head, press F3 whilst running the game and the Design Notes will 

be yours. 

Pressing F2 invokes a feature called the Parameter Data Dialog. It provides a host of information including 
movement costs, terrain benefits and stacking limits amongst other things. 
 
Documentation for the game’s editors may be found in the following help files: 

 Scenario Editor Help Manual – mpedit.pdf 

 Campaign Editor Help Manual – mpcamp.pdf 

For updates, downloads and the latest information visit WDS at https://wargameds.com/ or email 

Helpdesk@wargameds.com 

You can also head over to the official forums and ask questions or discuss the games with fellow enthusiasts. Visit 

the Musket & Pike section here - https://forum.wargameds.com/viewforum.php?f=16 
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